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RESUMO

Título: Point Cloud Filtering
Autor: André Núncio de Oliveira Sol
Orientador: Prof. Daniel Chaves Café
Programa de Pós-Graduação em Engenharia Elétrica
Brasília, 17 de fevereiro de 2020

Este trabalho realiza uma revisão dos diversos métodos existentes para a filtragem de
nuvem de pontos. Com o foco em reconstrução de objetos de pequeno porte escaneados a
laser. O escâner utilizado foi desenvolvido na própria universidade e é composto por um
sensor de distância a laser VL53L0X, baseado em tecnologia Time of Flight (ToF), e dois
motores de passo, um para mover o sensor e outro para o objeto.

Apresentam-se cinco princípios de filtragem: filtragem de forma estatística, filtragem
baseada na vizinhança de pontos, filtragem por projeção em superfície, técnicas de proces-
samento de sinais e por meio equações diferenciais parciais. Os métodos foram aplicados
Moving Least Squares, Operador Laplaciano, Operador de Taubain e simplificação de nuvem
com o auxílio do software MeshLab.

Testou-se duas amostra de nuvem de pontos, uma criada por computador e outra amos-
trada pelo escâner 3D do laboratório. Variou-se os parâmetros dos filtros e por fim realizou-se
uma análise qualitativa de ambos os resultados.

Palavras-chave: Nuvem de Pontos, Filtragem de Dados, Escâner 3D, Reconstrução de Ob-
jetos.



ABSTRACT

Title: Filtragem de Point Clouds
Author: André Núncio de Oliveira Sol
Supervisor: Prof. Daniel Chaves Café
Graduate Program in Eletrical Engineering
Brasília, February 17th, 2020

This work reviews several filtering methods for point cloud filtering. The main objective
is to recreate in a virtual environment small objects sampled from a 3D scanner. The scanning
device used was developed at the university. It is made of a laser ranging sensor, called
VL53L0X, that uses the time of flight (ToF) technology, and two stepper motors to move the
sensor and the object.

Five filtering principles are shown: statistical-based filtering, neighborhood-based fil-
tering, projection-based, signal processing methods and partial differential equations based.
With the use of MeshLab software tested the filtering methods. At the end the reconstruc-
tion of smooth surfaces from the scanner samples was possible. The Moving Least Squares
Algorithm, Laplacian operator, Taubain operator and Point Simplification were applied with
the MeshLab software.

Two point clouds were tested. One created by a computer and the other sampled from a
real object by the 3D scanner. Varying the filters parameters we tested the quality gain after
the usage.

Keywords: Point Cloud, Data Filtering, 3D Scanner, Object Reconstruction.
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INTRODUCTION

In 2018, the Rio de Janeiro National Museum, the biggest Natural History Museum in Latin
America [6], suffered a fire that destroyed cultural and historical artifacts. The unique, ir-
recoverable items that were lost represented the legacy and history of our past. Such a great
loss strive people to find better ways to preserve such heritage. In order to preserve these
objects in a virtual space we propose a 3D scanner capable of generating a virtual afterimage
of a existing object. Jeremy [7] started the project in 2018 by doing a technological review
for suitable parts and equipment and Ricardo [8] continued it in 2019 by designing the final
mechanical parts and assembly the 3D scanner, later on his work he scanned a few objects,
which a used in this work.

The idea of a virtual museum is not new. The advancements in 3D cameras propelled
new forms of cataloging and sharing objects that serve as records of history and culture.
However, this technology proved to be too costly and requires skilled labor to operate, which
goes against the idea of accessibility. The main focus of this project is the implementation
of a low-cost manufacture and easy operation 3D scanner.

The goal is to provide a low-cost, easy to operate, 3D scanner to be used by professionals
and hobbyists that crave to reproduce real world objects in a virtual 3D environment. Some
of the possible uses are: Preserve museum artifact in a digital form, reverse engineer a
mechanical part for later reproduction, make it easy to create to create virtual environments
with real world objects and so on.

1.1 PROJECT HISTORY

The project started in 2018 with a technology review for the selection of possible sensors
and materials [7]. In order for the proposed scanner to get the upperhand against the ones
available on the market it must be cheaper. The focus of the project was set at low-cost 3D
scanner. The parts to build it chosen accordingly. Taking on from Jeremy’s work Ricardo
[8] built the first prototype, as shown Fig 1.1, using the chosen laser ranging sensor and two
stepper motors. Ricardo designed the mechanical parts missing from the project and 3D
printed them. In his work he characterized the sensor and assembled the 3D scanner. The
prototype is capable of scanning small objects.

1
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Figure 1.1 – Prototype front view at the left. Top view at the right

Reproducing an object to the digital world is acquiring the geometrical proprieties of
its surface. The best way found by Jeremy’s work is measuring the distance of the surface
from a certain referential. In the variety of sensors capable of acquiring distances three were
discussed: Magnetic, Sound and Optic sensors.

The magnetic sensors are able to measure distance from metallic objects only, and there-
fore can’t be used generically. sound and optic sensors both share the same principle, they
use the ToF method. A signal is sent from an emitter and then reflects on the surface. The
signal then returns to the receiver part of the sensor. The time that the signal travels from
the emitter to the receiver is measured. The speed of the emitted signal is known, so the
sensor is able to determine the distance from the reflection point and itself. Analyzing the
propagation characteristics of the both options, the laser emitting proves to be more precise
as light emission can be more focused than sound.

The mechanical part was designed inspired in 3D printed technology. A vertical rail
guides the sensor and a rotatory base spin the object so it can be scanned, one point at a time.
After several rotations and adjustments all the points collected are saved in a file. This file
becomes the signal that represents the physical object.

Nonetheless these signals suffer a great amount of deterioration. Noise contamination
and outliers corrupt part of the data. These artifacts come from several reasons, such as
limitations of the sensors, inherent noise of the acquisition device, light or reflecting nature
of the scanned object.

2



1.2 OBJECTIVES

The objective of this work is to provide a software solution to the inherent noise caused
by the ToF light sensor of the low-cost 3D scanner. This work will focus on noise removal
and outliers cropping.

1.2.1 Specific Objectives

• Study the visualization software for point clouds.

• Implement noise removal filters to the point cloud.

• Implement outlier cropping filters to the point cloud.

• Reconstruct point cloud surface.

• Compare results to the real objective.

1.2.2 Text Form

This work is divided in: Literature Review, Methodology, Results, Conclusion. Litera-
ture reviews presents the important concepts needed to understand the process and clarify the
terminology used trough the work. Methodology show how the experiments were done and
how to reproduce them. Results show the the final reconstructions and important features.
Lastly, conclusion show the knowledge acquired by this work.

3



LITERATURE REVIEW

This chapter explains the terms and the techniques studied for this work. Start with the review
on point clouds and the VL53L0X sensor used to acquire them. Then moves to 3D filtering
and reviews the statistical-based filtering, neighborhood-based filtering, projection-based fil-
tering, signal processing based techniques, partial differential equations based filtering and
hybrid techniques.

2.1 POINT CLOUDS

Point Cloud is a new primitive representation of objects [9]. It consists of data points
scattered in space, that forms the surface of an object. Essentially, points are samples of a
3D object. The points are tree dimensional vectors that represent the spatial coordinates x,
y, and z. Point Clouds are represented by a list of all points of an object. Different from
pixels, vectors and polygons, point clouds have a more powerful representation capability
and flexibility due to its own simplicity. It does not store or maintain the polygonal-mesh
connectivity, making it a light digital representation of a 3D object. The data structure of the
point clouds is basically a list of three dimensional positions that determine a point in space.

Such advantage makes it easier to process and handle as there is less overhead in algo-
rithms and better performance. However this is not the only reason of its popularity. Many
sensors deliver data in a format that is very close to a point cloud. Using a point cloud data
format leverages the process of data acquisition as well.

Laser Detection and Ranging (LADAR) measure distance using light delay from the laser
it emits. Several applications need this type of data to work, such as autonomous vehicles,
object recognition and 3D scanning for digitization of real world objects. The raw data
acquired by such techniques are the collection of points.

Other options for 3D surface representation are Non-Uniform Rational B-Splines (NURBS)
[10] and polygonal meshes[11]. The former is very successful in Computer Aided Geomet-
ric Design (CAGD). NURBS was developed by automobile engineers with the intention of
modeling car parts. It consists in parametric surfaces determined by tensors. The latter is
very popular in rendering. It has more flexibility and precision than NURBS, but still fall
behind in simplicity when compared with point clouds.

4
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2.2 SENSOR VL53L0X

Manufactured by the STMicroeletronics the VL53L0X sensor is a ToF laser-ranging that
can measure up to two meters, according to the manufacturer. After been tested it showed
some particular behavior. It is heavily affected by the reflective and refraction characteristics
of the target. The sensor is also affected by the color of the object it is measuring. Its aperture
can measure points at closer distance and from afar at the same time, which generates noisy
data.

2.2.1 Time of Flight (ToF) Technology

ToF is a measurement of the time taken for a signal to run a certain distance, in this
case a electromagnetic wave is emitted by the sensor and it is reflected on the surface of
the target, traveling back to the sensor and hitting the receiver module. Since the speed of
light is constant in the air, it is possible to determine the distance of the target by the time
delay of the two signals, the emitted and the received. The Fig 2.1 shows the schematic of
the sensor function. The signal time is measured by the phase shift between emitted and
received signals.

Figure 2.1 – ToF schematic

2.2.2 Low-Pass Characteristics

The sensor makes several measurements of the same point and then send the average
value, which by itself classifies as a low-pass filter. However, the light emitted by the sensor
also suffer diffraction alongside the path traveled, transforming the field of vision of the
sensor into a cone instead of an ideal line. Thereby different points inside the sensor’s circle
of sight are measured as one, smoothing the surface locally.
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2.2.3 Noise Corruption

Aside from the white noise typical of electronic devices, this sensor suffer from three
particular noise sources: Cross-talk noise, Refractive and reflective proprieties and signal
diffraction. The cross-talk noise is natural to the sensor installation. The manufacturer rec-
ommend using a translucent protective shield in front of the sensor’s emitter and receiver, to
protect it from dust and other particles capable of blocking it. The protective shield causes
part of the signal to reflect on it, and cause different signals to reach the receiver. The re-
flection in the protective shield gives the impression that the object is closer than it actually
is.

Secondly the refractive and reflective nature of the target directly weights in the measure-
ment, depending on how translucent or the color of the object the laser might travel different
paths before reaching back. Lastly the aperture of the sensor being a cone creates artifacts
close to the edges, since it measures points that are faraway and close to the sensor at the
same sampling window, when it averages these values it gets noisy points.

2.3 3D FILTERING

Filtering is a wide area of research and is usually the first step on any data processing
pipeline[12]. Many techniques used for other data structures can be adapted for points. Point
cloud filtering is in fact an adaptation of classical mesh, image and video filtering.

The adaptation of digital image algorithms is not direct, for three reasons [2]. Irregularity:
point clouds do not require regular sampling like audio or images. In a point cloud different
regions may have different point density. Shrinkage: the effect of moving points for lessening
the energy on the point cloud, which moves the points closer to each other may cause the
total volume of the cloud to decrease. At last Drifting: moving a group of points in one
direction causes spatial displacement of regions.

The methods will be divided in groups, commonly used in the literature. Statistical-
based, Neighborhood-based, Projection-based, Signal Processing Based, PDE Based and at
last the Hybrid and Miscellaneous methods. These methods consist in using the geometrical
and spatial properties of the three dimensional data points to properly reconstruct the surface.

Robustness in filtering means that the technique works well on noisy data with small
errors and gross errors equals to outliers. [1]

6



2.3.1 Statistical-Based

Consider a point cloud as a set of samples that are attached to a real object. The adap-
tation of statistical techniques are suitable for point cloud processing. The correlation and
point distribution along the signal are proper to statistical distributions.

A non parametric kernel density estimation scheme was proposed by Shall et al. [1].
The main idea is to find cluster centers. Points that better represent the surface around it.
This method delivers an accurate approximation of the surface desired. Then use the mean
shift[13] technique to detect local maxima. Clusters associated with the maxima are detected
by a threshold. Despite being a good technique for noise attenuation sharp features are also
smoothed like the texture on the statue hair as shown in Fig 2.2.

Figure 2.2 – First column the noisy data and the second column the filtered data[1]

Principal Component Analysis PCA[2] is another statistical-based method widely ap-
plied in data simplification and study. This technique is usually employed to reduce dimen-
sions and bias cutback. Implementing PCA into a small group of points will return a matrix
with three eigenvalues. Eigenvalues represents the best plane to fit those points. The first
eigenvector represents the normal of the plane. Nevertheless the PCA is very sensitive to
outliers as shown in Fig 2.3, so it is usually applied a variation of the PCA in the literature,
weighting the point for feature preservation, shrinkage prevention and bias correction. Fig
2.4 shows the result of the proposed method by Leal et al.
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Figure 2.3 – Left: PCA without weighting. Right: with the proper weighting[2]. The red
dots are outliers

Figure 2.4 – Original Model, Noisy Model and Filtered Model[2]

One of the most canonical forms to solve reconstruction problems are the application
of Baysean Statistics. Jenke et al. [3] propose a technique for noise removal and scene
reconstruction. Start with the assumption of a scene S made of n points. Delete some points
leaving m points. Finally some random noise is injected into the remaining points, creating
the measured scene D. To construct the estimated point cloud S̃, every m point of D is
associated to an n point of S̃.

These points affect the a likelihood of scene S̃ has (P(S̃|D)) in terms of its a priori proba-
bility P(S̃) and posteriori probability P(D|S̃). The remaining points (n −m) are placed near
the m points with probability inversely proportional to the measurement sample density,
since these only affect P(S̃). This method does not work well if there is already holes in the
measured surface. Small holes are filled automatically, larger ones must be filled manually,
as shown in Fig 2.5
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Figure 2.5 – Scanned Data, Reconstruction, Manual Hole Filling, Final Rendering[3]

Kalogerakis et al. [4] show that points clouds can be filtered based on Interactively
Reweighted Least Squares (IRLS) a framework based on computing the curvature of the
point cloud trough a maximum estimation of likelihoods. This method refines the shape
of every point’s neighborhood by weighting samples through a fitting error. The kernel
used to read the neighborhood must automatically adapt to the surface, getting larger near
irregularities, heavy noise and edges.

This method computes the point normal by estimating curvatures, showing better results
than PCA-based methods. After that the global energy of the point cloud is minimized in
order to denoise it, while extracting the curvatures of the discontinuities in order to give
robustness against surfaces of any kind. The Fig 2.6 show how the curvature lines still
follows the object even with noise and density irregularity of points.

Figure 2.6 – Regularly sampled torus and Noisy random sampled torus[4]

At last, encouraged by sparse signal reconstruction and compressive sampling Avron et
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al. propose L1-minimization techniques for point clouds [5]. Common objects can often
be characterized by a small number of features even the geometrically complex ones. Uti-
lizing L1-minimization for sparse signal reconstruction. A method is applied first solving
for points normal orientations. This method achieves better result than PCA based. Solve
for point positions as shown in Fig 2.7 based on surface smoothness. For better results the
L1-minimization is reweighted to achieve better sparsity reconstruction [14]. With the adap-
tive weights the method can recover surfaces with less samples. This technique shows good
result even for high textured objects.

Figure 2.7 – Noisy V-shape, Normal Regularization and Point Position Regularization[5]

Figure 2.8 – Real Object, Scanned Object and Reconstitution[5]

Alongside the adaptation of L0-minimization for 2D images Sun et al [15] proposed an
algorithm that outperform the former and enhances the Edge Aware Upsampling (EAR) al-
gorithm. EAR is used to generate more points based on the existing ones for better rendering.
As shown in Fig 2.9 this method can perceive sharper features.
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Figure 2.9 – Smoothing 1D signal using different norms[15]

2.3.2 Neighborhood-Based

Neighborhood filtering is the determination of a point position in account of similarity
measures between it and the closest points. The point neighborhood can be determined by
point positions, normal and regions.

The Mean Shift Filter [16] is a dynamic nonlinear filter. It achieves a high quality filtering
while preserving discontinuities. As many techniques, this was also adapted from image
processing field to 3D data. It is done by taking vertex normal and curvature as the range
instead of pixel intensity and position as spatial component. Then the points are saved as a
dataset based on these components. It is divided in small groups called patches. Find the
local mode of each sample point and cluster points of similar local modes. Fig 2.10 shows
the modes been separated by octree [17] method. This method uses octree separation for
better performance. It is a very simple method but does not preserve sharp features.
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Figure 2.10 – Separation by octree [16]

Filters designed for range scans are heavily based on image algorithms, since its data
structure mirrors the grid of an actual photograph. Bilateral filtering[18] is heavily used in
such conditions, it is applied switching the pixel intensity by other measures [19]. Schall et
al [20] designed a non-local neighborhood filter that determines the denoised position of a
vertex as a weighted average of similar vertices in its vicinity. Comparing regions generate
better results than comparing range and normals. For colored scans the color is used to
weight on region selection for points since continuous surfaces tend to have the same color
along itself [21].

Fig 2.11 shows the noise reduction of Shall’s algorithm, the green images represent the
contrast on the point cloud surface. After processing the sharper regions are limited to the
sharper features.
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Figure 2.11 – First Row is Noise data, Second is Bilateral Filtering and Third is Shcall et al
method [20]

Considering the problem of low-quality data from range scans, a connectivity-based out-
lier detection method [22] was proposed. It is insensitive to the size of the chosen neighbor-
hood. This technique generates better results on high noise regions.

Determining the correct neighborhood depends on where the point is. Several planes
on the point neighborhood are selected and sorted properly, while keeping sharp features
undistorted. This method designed is for scanning city scenes. Composed from big blocks
of buildings. It may not work well on a more populated environment like forest and parks.

2.3.3 Projection-Based

Projection-based techniques are the ones which the final position of a point is determined
by its projection on a reference. A good example is the point cloud skeleton algorithms, they
grasp the simplest structure of an object. Based on L1-medial for data points. The work
proposed on [23] creates a good reference to project data points. Fig 2.12 shows an example.
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Figure 2.12 – Dinosaur model, Raw scan and skeleton generated [23]

Lipman et al. Proposes the LOP operator [24]. It uses a more primitive projection mech-
anism, but since it is not 2D it is more robust and goes well in complex settings. It is a
projection operator rather than a filter and heavily used in preprocessing. Nonetheless it can
be used to reduce noise and crop outliers. It uses the statistical tool L1 Median to calculate
the projection. Fig 2.13 shows the smoothness achieved by the LOP operator

Figure 2.13 – Noisy data and LOP reconstruction [24]

However LOP algorithm doesn’t work well on non-uniform distribution. Fig 2.14 shows
the distribution of projections. The LOP projection mirror the data distribution, so they are
projected non-uniformly. To overcome this barrier, the WLOP [25] was proposed. With a
parameter that factor the point to a even distribution. This factor may cause the shrinkage of
the point cloud if it is too large or cause it to diminish any denoise.
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Figure 2.14 – Original data, LOP projection, WLOP projection [25]

Whereas these two last techniques have really good performance in noise removal, they
don’t do well in feature preserving. Sharp features are smoothed or distorted by those al-
gorithms. With that in mid the FLOP was proposed [26] by Liao et al. It creates a feature
preservation weight. First it is applied a bilateral-weighted local optimal projection for fea-
ture preserving. Then it takes both spatial and geometrical information. FLOP is based on
Kernel Density Estimate (KDE) [27], an adaptative local parameter. The author even propose
a filter for time-varying data Spatial Temporal LOP (STLOP).

Fig 2.15 shows the effect on redistributing the points. Sharper features require more
points to be represented, by projecting without regard of region LOP and WLOP can not
reconstruct sharp features well. FLOP keep more points on edges so it wont be distorted.

Figure 2.15 – Original data, LOP projection, WLOP projection, FLOP projection [26]

For better performance switch the point projection for gaussians, using Gaussian Mixture
Technique (GMM) to WLOP creating Continuous LOP (CLOP) [28]. This method has better
computer performance and generates smoother surfaces.

A different but very common use is the Moving Least Squares MLS [29], a process to
find a local plane and project the point upon it. This method is very popular and already had
been modified by different authors. The main reason is the fact that it is a low-pass filter
that shrinks the point cloud and the nonlinear part of the process. Alexa et al [30] proposes
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the substitution of the non-linearity of the MLS for an weighted average. Mederos et al
[31] adapts statistical theory to improve MLS in order to preserve sharp features, applying
a M-estimator. Fig 2.16 show the smoothness achieved and the texture preservation of this
method.

Figure 2.16 – Noisy Object, Improved MLS, Original MLS [31]

Employing the forward-search paradigm Fleishman et al [32] find the best neighbors to
apply the MLS projection, providing great gain in edge preservation and noise filtering. As
shown in Fig 2.17. The edges of the box are better represented. The MLS makes them
rounded.

Figure 2.17 – Normal MLS and Fleishman’s MLS 2.17
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2.3.4 Signal Processing Based

Adapting the signal processing pipelines to point cloud processing results in fast applica-
tions which are ideal for real time analysis. The Laplacian operator transforms an optimiza-
tion problem into a low-pass filter design problem [33]. Yet this method causes shrinkage.
To solve this problem, proportional cylindrical rescaling is applied to the whole point cloud
[34].

The result can be seen in Fig 2.18 where the left image shows the local rescaling and the
right one shows global rescaling, the middle is the original point cloud. The local technique
has less distortion when compared to the global approach.

Figure 2.18 – Result of Laplacian Operator 2.18

Perhaps the most famous operation in signal processing is the Fourier Transform (FT).
The FT has several problems when adapting to point clouds. FT requires global parametriza-
tion, regular sampling pattern and more spatial localization. In order to solve these issues
the FT is applied in windows [35] that transform the irregular point cloud to sets of regularly
sampled height maps. The pipeline goes as follows.

Figure 2.19 – Fourier Transform Pipeline [35]

The points are clustered into selected patches. For better reconstruction these patches
keep the neighborhood information so they can be restitched back again. Then a fast Scat-
tered Data Approximation (SDA) is used to populate the grid with missing points. Then
Discrete Fourier Transform (DFT) is applied on the grid and filtering transformations on the
frequency spectrum. At last the process is undone to retrieve the point cloud again.
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2.3.5 PDE Based

PDE techniques is an important tool for computer vision and was also adapted to point
clouds. PDE can only be applied onto meshes. Since point clouds surfaces are not meshes
it can not be applied finite elements tools. To work around this problem Clarenz et al. [36]
proposed the creation of a number of local finite elements matrices over small neighbor-
hoods.The main idea is to combine points into surfaces and then solve the PDE problem.
However, this technique can’t keep sharp features. Another problem is the time consuming
step of computing the partial equation properties.

Figure 2.20 – First row original objects, second row filtered objects [36]

2.3.6 Hybrid and Miscellaneous

As noted, most of the shown applications involve several techniques, locally or globally.
It is hard to solve a problem with only one technique. Combining WLOP and mean shift
outlier removal [37] as shown in Fig 2.21 resulted in a very timing costly implementation
and yet won’t recover sharp features well. Another example is particle swarm estimation for
a KDE and than applying bilateral filter [38] as shown in the Fig 2.21.
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Figure 2.21 – Point Cloud, Noisy Object and Filtered Object [38]

Considering the initial state of development of the laboratory’s 3D scanner this work
chose the most general techniques. Techniques with easier implementation were prioritized
from difficult implementation ones. From Projection-based methods the MLS was chosen, it
has a good smoothing factor and doesn’t deform smooth surfaces only sharp features. From
Signal Processing the Laplacian and Taubain operators were chosen. This two methods
are simple and present good results. Taubain operator has a scaling factor that prevents
shrinkage. Lastly from Statistical-based filtering the Downsampling method was chosen.
It is not a good method for sharp features but it simplifies the point cloud, giving it an
advantages from the former cited.
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METHODOLOGY

3.1 SOFTWARE

Point Cloud manipulation requires specialized software even if the data structure is pretty
simple. For this work all the implementations were done in MatLab, MeshLab and Point
Cloud Library (PCL) [39], a C++ code for point cloud manipulation.

3.2 PROCEDURE

The test method occurred on a simple loop of action. Read the data from any source,
filter it on MeshLab and compare the quality results with others. First the data must be on
the Stanford Point Format called Polygon File Format (PLY). For that a simple MatLab code
for format conversion is used to transform the data.

Then the file is imported to MeshLab by going into File > Import Mesh Fig 3.1. Filtering
can start the point cloud shown on the monitor. Most of the filtering techniques require
extra information to work, like the point normals. For thats on MeshLab go to Filters>Point
Set>Compute Point Normals. The parameter to change is the Filter Scale for MLS and
Number of Samples for Point Cloud Simplification.

Figure 3.1 – Import Point Cloud in MeshLab

When scanning objects an artifact appears. The artifact is the strange toroid feature
that appears on top of scanned objects Fig 3.2.It is assumed that it happens because the
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sensor measure faraway points and close points in its measurement window. When the sensor
average those samples they get sparser. This phenomenon is yet to be investigated. For better
comparison the scanned data is split in two, one with the top artifact and another where it is
manually removed. The sensor aperture measures far and close points at the same time. To
remove points on the top right corner of the action menu click select vertexes and then after
selecting the points considered to be outliers click delete vertexes.

Figure 3.2 – Import Point Cloud in MeshLab

The filtering occurs by going on the Filter tab again an selection Point Set > either MLS
projection or Point Cloud Simplification 3.3 the other filter are in Filters> Smoothing, Fair-
ing and Deformation> Laplacian Smooth or Taubain Smooth. The changed parameters are
number of steps.
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Figure 3.3 – Normal Estimation, MLS and Downsampling options

Noisy synthetic data is generated by importing the original mesh and going to Filters >
Smoothing, Fairing and Deformation > Random Vertex Displacement. This action will add
gaussian noise to the data.

Lastly the point cloud is turned into a surface with the Poisson method. To do so go in
Filters > Remeshing, Simplification and Reconstruction > Screened Poisson Surface Recon-
struction. The default values were used to generate the surfaces.

The test will be made using synthetic point clouds and point clouds sampled from the 3D
scanner. The they will be compared visually for the quality of the reconstruction. The filters
applied to them will be using the values of Table 3.1 using the process shown in Fig 3.4.
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Method Parameters Values

MLS
Filter Scale

4
10

Projection Accuracy 0.0001
Projection Max Iterations 15

Laplace Smoothing Steps 3

Taubain
Lambda 1
mu 0.53
Smoothing steps 10

Downsampling Number of Samples 1000

Table 3.1 – Table with the filters Parameters
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3.3 FLOWCHART

Scan Real Object Download from Open
Library

Sample Synthetic
Object

Data conversion PCD
to PLY on MatLab

Open on MeshLab

Compute point
normals

Apply Filter

Render Surface

Get Point Cloud

Compare with orignal

Figure 3.4 – Procedure Flowchart
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RESULTS

In order to compare the visual result of both of them. The results are divided in synthetic and
sampled.

4.1 SYNTHETIC RESULTS

The filter algorithms were tested in a synthetic point cloud in the shape of a bunny,
provided by the University of Stanford [40]. Shown in Fig 4.1.

Figure 4.1 – Original synthetic point cloud

Then Apply gaussian noise to the point cloud as in Fig 4.2.
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Figure 4.2 – Noisy synthetic point cloud

Figure 4.3 – Top left is the MLS filtered, Top right is the downsampling filtered, bottom left
is Laplacian operator and bottom right is Taubain operator
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As shown in Fig 4.3 all filter recover the original shape of the object, however the down-
sampling and the Laplacian operator achieves poorer results, which is expected from simpler
methods. The surface is very rough. Great distortions can be noted in the bunny ears at the
downsampling result.

The MLS and Taubain methods recover better hulls, the Taubain operator achieves better
reconstruction of sharp features, the bunny snout and eye region show more detail. This also
match the expectation, since the Taubain operator is a more refined technique.

4.2 SAMPLED RESULTS

For the sampled results a doll was sampled. As shown in Fig 4.4. The data acquired
directly from the sensor is very noisy, what can clearly be seen in Fig 4.5. Manually removing
the artifacts generated by the sensor incapability to acquire sharp edges from small objects
gives more form to the object.
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Figure 4.4 – Original object scanned

Figure 4.5 – Raw data rendered at the left and the removal of the artifact
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4.2.1 Projection based method

Applying the MLS algorithm shows how the artifact effect the processing of the point
cloud. Since MLS is a smoothing procedure in tends to merge surfaces in order to achieve
less noisy shallows. As shown in Fig 4.6.

Figure 4.6 – First row the MLS with size 4 is applied, second row the MLS with size 10

The size of the MLS algorithm changes how much noise will be removed. Scaling up
the filter create a smoother surface. However it also round sharp features. Applying a small
kernel leaves the surface still noisy. The bigger one smoothes features together.

Note the artifact has a lot of weight in filtering, it basically merges itself in some sort of
a crown, damaging the reconstruction. As stated before in the review the MLS filter causes
shrinkage of the point cloud. However the factor used above does not lead to a good visual
cue. Fig 4.7 shows the point cloud with the filter at size 50. The whole object turns into
cylinder.
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Figure 4.7 – Point cloud after the MLS with size 50

4.2.2 Signal processing method

Results of applying the Laplacian operator trough the point cloud Fig 4.8. The Laplacian
operator smooth surfaces indiscriminately. It is a fairly simple matrix operation, reduces
small amplitude noise leaving rougher surfaces noisy.
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Figure 4.8 – Top row raw pint data and bottom row the Laplacian operator

As displayed the Laplacian operator smooth most of the surface eliminating the acquisi-
tion noise, yet at the back of the object there is still rough regions.
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Figure 4.9 – First figure Taubain operator with 10 steps, second figure Taubain with 50 steps

Taubain operator shows a smoother surface and the sharp features get smoothed more
than MLS. However since the shrinkage parameter is controllable, the point cloud is not
deformed as much. Proving that Taubain operator is the most adequate method for this stage
of the 3D scanner.

4.3 SURFACE CHARACTERISTICS WEIGHT

The sensor utilizes light to measure objects. Therefore the objects color, reflexibility
and refractibility weights on the measurement. Darker colors makes the object appear more
distant while bright colors make the object appear closer. This happens because darker colors
absorbs more light frequency and therefore the signal reflected on them is weaker. A weaker
signal may appear to be a distant signal for the sensor. The opacity of the object seems
also more distant, since the light goes trough it and reflects behind the surface. The signal
pervieved by the receiver is measured more distant. The Fig 4.10 shows the effect where
covering the red cheek of the Pikachu toy makes the measurement appear closer. However
the black of the eyes still creates sags on the scanned reconstruction.
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Figure 4.10 – Scan with the occluded translucent part
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CONCLUSION

Point Cloud filtering definitely helps at the reconstruction of 3D scanned objects. Removing
noise and retrieving sharper features is possible. However it is clearly shown that for this
setup the quality of the scan is not matched to the desired objective of reconstruction of
historical artifacts. Simpler objects that are less textured may show better results. Since the
main objective is a low-cost proposition of 3D scanning a better treatment for the sensor
modeling should help the results.

One thing that is well clear for all the applications reviewed in this work is the specificity
of every one of them. Every solution is uniquely attached to a single problem, i.e. connected
to a specific setup or sensor. For better performance in reconstruction the filtering technique
must keep evolving together with the 3D scanner evolution. Considering this is the first
iteration on the software level of the project and many more to come, filtering shows great
potential for object precise reconstruction.

The statistical techniques when applied with the projection techniques show good results
in denoising and reconstruction of complex objects. These techniques can treat edges and
sharp features well. However they are time costly. Signal processing techniques are simpler
and can smooth small amplitude noise. These are better suited for denoiseing objects with
simpler geometrical configuration and precise sampling. The downsampling technique is
not appropriate for this project. The number of samples are too small for denoising by
simplification.

5.1 FUTURE WORK

• Modeling of the sensor activity during the scanning, so simpler noise and outliers
canceling methods can be performed. For example the application of Kalman filter
for the distance measurement. This change may help canceling the appearance of
artifacts on edges. It is more robust than moving average algorithm. The later is
heavily influenced by outliers.

• Addition of more sensor so multi signal filtering and data fusion can be applied. The
addition to a secondary sensor that capture the same scene creates redundancy. More
sensor leads to uncertainty reduction and better samples. The second sensor can be on
top of the rotatory platform. In this configuration it wont have much correlation with
the main senor. However by measuring the top of objects uprightly may reduce the
artifact appeared on top of them.
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• Study of color effect on scanned data, the results show a huge bias of the sensor when it
comes to scanning different colored pars of the same surface. Scanning know objects.
For example cylinders made with known height and radius. Then coloring them with
different colors and patterns. After scanning the distortion can be actually measured.
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